BASINS/HSPFE Training Exercises

Exercise 4 — Introduction to WinHSPF and GenScn
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In this exercise, you will learn how to build and run a WinHSPF project. We will add three
shape files (outlets, streams, and subbasins) to our BASINS project. These files are
associated with the watershed delineation for the West Branch Patuxent River and are
necessary to launch WinHSPF from BASINS. They can be created using the BASINS
manual delineation tool or automatic delineation tool. Using these files, we will launch
WIinHSPF from the BASINS interface.

The WinHSPF interface includes many useful tools and user-input windows, many of which
allow user-specified parameter adjustments. Because our goal during this exercise is to help
you gain a basic understanding of WinHSPF and GenScn, we will leave most of the inputs as
the default values. After we have explained each of the tools and some of the input tables,
we will run our WinHSPF model for flow.

One of the most important aspects of modeling watersheds is hydrology calibration. In order
to ascertain how well our model is simulating conditions in our watershed, we need to
compare the model’s output to observed data. In this exercise, we will download historical
streamflow data, add it to our project’s output file, and then use GenScn to plot the simulated
streamflow on the same graph as the observed streamflow. In Exercises 5 and 6, we will
learn how to calibrate our model’s hydrology so that it more accurately predicts streamflow.

Questions addressed in this exercise:
1) How do I import Subbasins, Streams, and Outlets layers into my BASINS project?
2) How do I launch WinHSPF from BASINS?
3) What tools are available within WinHSPF?
4) How do | run my WinHSPF model?
5) How do I add gage data to my WinHSPF project file?
6) How do I use GenScn to view my simulation results?

A. Importing delineation layers

QUESTION ANSWERED:
1) How do | import Subbasins, Streams, and Outlets layers into my BASINS project?

1. If BASINS isn’t open, from the Start menu under Programs, select BASINS and
then BASINS 4.

2. Click “patuxent’ in the “Welcome to BASINS 4” window.
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3. To avoid confusion, remove the Streams, Subbasins, and Outlets layers produced
during the previous exercise by right-clicking on each layer and selecting “Remove
Layer”. Also remove the results of the automatic delineation from the map legend.

Note: Map layers representing Streams and Subbasins are required in order to launch
WIinHSPF from the BASINS interface. An Outlets layer is optional. These
files can be created using the manual delineation tool or the automatic
delineation tool. In this case these files were created by the automatic

delineation tool. We will use these predefined map layers so that everybody
will have the same model results.

4. Click E (Add Layer tool).

5. Navigate to c:\basins\predefined delineations\west branch\ and select all three
shapefiles in the folder.

21x

Laak jn: I@WestBlanch j & £ E5-

File name: I"wb_subs.shp" "wb_strms.zhp" "wb_outs shp" j Open I
Filez of type: IAII supported formats j Cancel |

P

6. Click OPEN. Three layers (Streams wb_strms.shp, Subbasins wb_subs.shp, and
Outlets wb_outs.shp) will be added to the map.

7. Turn “off” all layers except Streams, Subbasins, Outlets, State Boundaries, and
Cataloging Unit Boundaries.

8. Make sure the Outlets and Streams layers are displayed on top of the Subbasins layer.
Your view should look like the following.

4-2



BASINS/HSPFE Training Exercises

= BASING 4 - Palusent (=1
Fit Compite Modsk Lanch Analysis Edt View Pugins  Watershed Deineation  Shapefie Editoe  GIS Tools  Hep

DB SFE ¥ PR RA A -8 a0 TR
leend &%
%) Terrain Analvsis —

& Hvdreleav
T Roach File, V1 ~

332393 Y 4319353 Kilomaters M 32392725 ¥ 4319352 9 Maters

B. Launching WinHSPF from BASINS

QUESTION ANSWERED:
2) How do I launch WinHSPF from BASINS?

Now that we have added the new Subbasins, Streams, and Outlets layers, we will launch
WIinHSPF from the BASINS interface. When WinHSPF is launched from BASINS, an input
file (_uci) is created. HSPF uses the information found in BASINS to estimate values for
many parameter inputs. It should be noted that these values can be highly inaccurate and
should be modified if more accurate information is available.

1. From the Plug-ins menu, make sure Model Setup (HSPF/AQUATOX) is checked

(on).
Plug-ins | Shapefile Editor  GIS Tools  He
Edit Plug-ins
Scripks. ..
Analysis 3
[¥] Basms4
[¥] &5 o0k
Z Manual Delineation
v | Madel Setup (HSPRACUATOR)
Z Shapefile Editar
Timeseries 3
Watershed Delineation
2. Turn “on” and *“activate” the Subbasins layer.
3. Click (Select tool).

4, While holding down the CTRL key, click on all 6 subwatersheds.
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5. From the Models menu, select HSPF. (Be patient for a moment.)
6. The following window will appear. Enter “WestPat” in the “HSPF project name:”

box. Leave “USGS GIRAS Shapefile” in the “Land Use Type” box. Set Subasins to
be the “Subbasins Layer”, Streams to be the “Streams Layer”, and Outlets to be the
“Point Sources Layer”. Weather Station Sites 2006 will default to the “Met Stations

Layer”.
”. BASING HSPF -0 x|

General |Land USEI Stream5| Subbasins' Point SDur:ES' et SIaIiUnS'
HSPF Project Name: e stPat
Land Use Type IUSGS GIRAS Shapefile j
Subbasine Layer: ISubbaams j
Streams Layer: IS\reams j
Paint Sources Layer: |Out|ets j
Mt Stetions Layer:  [Weather Station Sites 2006 =l
Status

’7 Update specifications if desired, then click QK to proceed ‘

oK I Open Existing Cancel | Help | About |

7. Click the Land Use tab. The “Land Use” tab is used to specify the land use
classification scheme. This scheme includes information regarding the combined
land use classifications that will be used in HSPF as well as the impervious
percentages for each of the land use classifications.
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7. BASINS HSPF =l 1|
General LEIHdUSEl Streamsl Subhasins | Paint SDurcesl et Stations |
Classification File: /BASING/etc/giras. dbf Change

50
0
0
]
0
]

Status
’7 Update specifications if desired, then click OK to proceed

Ok | OpenEsttingl Cancel | Help | About |

Note: The “impervious percent” values indicate how much of each land use category
will be impervious to infiltration, such as paved area and rooftops. For
example, a 30% impervious percentage indicates that the given land use
category is 30% impervious and 70% pervious. The model uses this
information to estimate runoff from each land use type.

8. The Streams, Subbasins, and Point Sources tabs are used to map fields from those
map layers to variables used in building the HSPF model. These fields will default
appropriately when using the output of a BASINS watershed delineation tool, so we
will not have to change anything in these tabs for this example.

9. Click on the Met Stations tab. Because we specified Weather Station Sites 2006 as
the “Met Stations Layer”, the “Met WDM File” will be set to the WDM file
associated with the Weather Station Sites 2006, which is named ‘met.wdm’ and is
located in the “\BASINS\data\02060006° folder.

The list of the Met Stations tab will be populated with an identifier/description
corresponding to each meteorological station available in the WDM file for use in the new
HSPF project. One item from this list must be selected in order to have meteorological data
included in the HSPF simulation. (In Exercise 5 we will learn how to set up a new HSPF
project utilizing multiple met stations.) You should specify the meteorological station that
best represents your watershed.

The “Select’ button may be used to select another meteorological data file. Any WDM file

can be referenced as a met WDM file (as long as the file contains the necessary
meteorological data).
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¥ BASINS HSPF =1o|x|

Gemera\l Land Usel Slreamsl Subbasinsl Point Sources  Met Stations |

Met WDM File

IC.\BAS\NS\data\DZDBDDDB\met\met.wdm Select |

RMO160193 ANNAPOLIS POLICE BREKS (1951/4/1-2006/1/1) =
MO 160460: BALTIMORE SLEDDS POINT (1848/12/1-1857/3/1

“tAD 160465 BALTIMORE WASH INTL AP (1870/1/1-2007/1/1)
MD180470:BALTIMORE CITY (1948/5/1-1998/6/1)
MD180475: BALTIMORE HAMILTON (1948/8/1-19680/12/7)
“hD180700:BELTSYILLE (1970/1/1-2007/1/1)
MD180701T:BELTSYILLE PLANT STH 1{1943/1/1-1961/1/1)
MD180702.BELTSYILLE PLANT STH 2 {1943/1/1-1961/1/1)
MD180703:BELTSYILLE PLANT STM 3 (1948/1/1-1957/7/1)
MD150704:BELTSVILLE PLANT STM 4 {19458/1/1-1961/1/1)
MO150705 BELTSVILLE PLANT STM 5 (1948/1/1-1978/10/1)
MD150706:BELTSVILLE PLANT STM B {1948/1/1-1961/1/1)
MO150800: BETHESDA NATL INST HEALTH (1851/1/1-1860/8/1) |

* Full Set Available

Status
’7 Update specifications if desired, then click OK to proceed

Ok | OpenExistmgl Cancel | Help | About |

10. Select “MD180465: BALT-WASHGTN INTL AP” as the Met Station to use in this
HSPF project.

To determine which weather station to use, you may simply turn “on” and “activate” the
Weather Station Sites 2006 layer within BASINS, and then use the “ldentify” tool to
determine which station is closest (or most representative) of your watershed.

The “MD BELTSVILLE” station is actually closer to our watershed than the Baltimore-
Washington Airport station is; however, the Beltsville station that is included in the BASINS
database has some precipitation data gaps and therefore won’t be used for this particular
computer session.

The “*’ next to the met station name indicates that this station has the full set of meteorologic
constituents available. Stations without the *** can be used as the meteorologic inputs for an
HSPF hydrology simulation, but some met constituents will have to be specified from other
locations to simulate full range of HSPF water quality modules.

11.  Click OK.

Note: You will see some processing messages appear along with a status bar at the
bottom of the main BASINS window. During this time the HSPF User Control Input
(UCI) file will be created for the specified project.

After clicking OK, BASINS will create the HSPF User Control Input (UCI) file as specified.
The UCI file will be assigned the HSPF project name indicated on the General tab, in a
subfolder of the same name within the \BASINS\modelout folder. For example, for this HSPF
project a UCI file by the name WestPat.uci will be created in the \BASINS\modelout\WestPat
folder. A new WDM file called WestPat.wdm will also be created in this folder to be used
for storing the point source inputs to the model as well as any output time series from the
HSPF simulation.
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Once the UCI has been created, the main window of the HSPF interface (WinHSPF) will
open. This window contains several menus, a tool bar, a vertical tab strip, a schematic of the
watershed, and an auxiliary table. The vertical tab strip, watershed schematic, and auxiliary
table will not be active until a project is active (until a .uci file is opened or a project is
created). When WinHSPF is launched from BASINS, the corresponding .uci file will
automatically be opened. The information in the tab strip, the auxiliary tables, and the
watershed schematic are relevant to the open project.

'__ Hydrological Simulation Program - Fortran {(HSPF): westpat 8] x|
Eile Edit Functions Help Restore Down
R el e
Sl RS EET-IRS
: Perind  Implnd
[] Tool Bar

Farest Land \! \!
5 [ 1
o . . RCHRES 1 RCHRES G
3
~

2
@
E al Lar
=
&
. RCHRESZ RCHRESB

Barran Land
ietlands N

RCHREE &
Wiater J

Vertical
Tab Strip

Watershed
Schematic

“ROHRES 4

Land Use Reaches Imp].nd thax |pering (aeres) Total (Acres) |
Total 0.0 |

'\

C. BASINS WIinHSPF Tools

QUESTION ANSWERED:
4) What tools are available within WinHSPF?

The buttons on the tool bar, . ﬂ J’J n H rE: 1 m , provide

links to the various tools with which the user can interact with the open project. The buttons
to the left of the tool bar can be used for creating, opening, and saving projects. The “Run

Auxiliary Table

HSPF” button, 1 is used to perform the simulation (run HSPF). The other buttons on the
tool bar are used to view and modify input values and parameters of the open project and to
specify things such as the simulation period and constituents you would like modeled.

The vertical tab strip contains three tabs. The tabs, in conjunction with the figures in the
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watershed schematic, display information about the project in the auxiliary table. These
features can be used to specify whether to display information related to land surfaces, met
segments, and point sources. If you highlight items in the tab strip and highlight a figure in
the watershed schematic, related data will appear in the auxiliary table. For example, click
the “Land Surface” tab and then click the “Forest Land” icon. Click the “RCHRES 2” figure
in the watershed schematic. The auxiliary table will show the acres of forested area
contributing to Reach 2.

Clicking the “Met Segs” tab indicates which met segments are associated with each reach.
The auxiliary table will show information for the selected met segment contributing to the
selected reach. Information in the auxiliary table includes the constituent name, WDM data
set number, associated multiplication factor for the PERLND/IMPLND segments, associated
multiplication factor for the RCHRES segments, and the transformation function used to
adjust the time dimension of the data units as necessary (Duda et al., 2001).

The “Point Sources” tab is used to view the point sources that will contribute to the streams
in WIinHSPF. If you click on a point source, the stream segment to which it will contribute
flow and/or constituents will become highlighted in the watershed schematic and data
regarding the source will appear in the auxiliary table.

In order to hecome more familiar with the WinHSPF interface, we will click on each button
in tool bar and view the various tools, options, and default input values.

WInHSPF Reach Editor

1. Click D (Reach Properties Editor). This editor allows you to modify select
properties of each reach. The following screen will appear:

¥ _WinHSPF - Reach Editor o =]
I | Descrption | Length [mi]| DeltaH [ft]| annstreamID| M E:-:its| Lake Flag
1 [“estemn Branch Patus 9.E6 hE 2 ]
2 | Southwest Branch Wes 1237 200 L 1 ]
3| South Collington Bra 396 3 L 1 ]
4 | South Reach, Westem 2595 7 ] 1 ]
5 [“estern Branch Patus 047 1] 4 1 ]
E |Moarth Colington Bra 216 102 3 1 ]

Note: The values in the “Reach Editor” table are automatically calculated when
either the manual or automatic delineation tools are used to create the Streams
layer. If neither of these tools is used, the user must make sure these fields
and their corresponding values are included in the attributes of the Streams
shapefile before launching WinHSPF.

2. Click FTABLES. The “Edit Ftable” window will open.
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2. Edit Ftable —[of x|
FTable: |FErmyspem"m ern
Depth (ﬂ)| Area (acres)| “olume (acre—f'l)| Outflow (ft3/5) )
NR 3
0 3657 1] 0 aws 8
0.37 35.83 131 11.43 NCols: 4
367 3814 13835 527.69
459 38.84 17069 764.79 Import From
573 116.86 30379 972.87 Cross Section
£.88 11856 438.77 17771
118.14 27755 2247036 Ba6228.7 Compute New
2294 436.6 6219717 2737217
F-Curve |
OK Cancel Apply | Help |

Note: WinHSPF estimates the depth and width of individual reaches using some
simple assumptions and the drainage area of a subbasin. These estimates are
generally inaccurate, but they are better than nothing. It is best to gather data
for your watershed’s individual reaches and then use cross-sectional
characteristics to populate the F-Tables by either estimating the stage-
discharge relationship with an equation such as the Manning’s Equation and
then entering them manually or by using the “Import From Cross Section” tool.

In this exercise, we will use the default F-tables.

F-Curve

3. Click A graph that shows the relationship between the depth (stage)
and reach flow rates will appear.

F-Curve for Reach 4 {South Reach, Western Branch}) - |EI|5|

File Edit Wiew

5000000 T ; ;
4500000 |- i
4000000
3300000

= 3000000

=

& 2500000

= 2000000

)

1500000
1000000
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4. From the File menu, select Close.

Import From

5. Click Crozz Section
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i_ Import From Cross-Section - |EI|5|
Cross-Section Files

’7 Open I 'l Save |
FTABLE 3

“ariable | Description Walue
L Length [ft] 0o
m tean Depth [ft] 0o
Wm tean Wwidth [it] 0o
n Mannings Foughress Coefficient 0.m
S Longitudinal Slope 0.m
ma2 Side Slope of Upper Flood Plain Left 0.m
m22 Side Slope of Lower Flood Plain Left 0o
W2 Zero Slope Flood Plain Width Left [ft] 0o
ml2 Side Slope of Channel Left 0o
mll Side Slope of Channel Right 0.
Wl Zero Slope Flood Plain 'width Right (i) 0.m
mal Side Slope Lower Flood Plain Right 0.m
mal Side Slope Upper Flood Plain Right 0m
Yo Channel Depth [ft] 0o
it Flood Side Slope Change at Depth [ft] 0o
T2 t aximum Depth [ft] 0.0

oK | Cancel | Help |

Note: Using this editor, you can modify the cross section characteristics or import a
table that contains the cross-sectional data (*.rtf file).

6. Click CANCEL to exit the “Import From Cross-Section” window.

7. Click OK to exit the “Edit FTable” screen.

8. Click OK to exit the “Reach Editor” window.

WinHSPF Simulation Time Editor

A *.wdm file containing meteorological time series data was specified in the “Create Project”
window. In the Simulation Time Editor, you should specify a simulation period (the default
time period is for all dates included in your meteorological data file — this time period is

usually very long (several decades). The period you specify must be within the time range of
data included in your meteorological *.wdm file.

1. Click (Simulation Time and Meteorological Data).

2. Enter the dates shown below for the ‘Start” and ‘End’ of the simulation.
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|'__ WinHSPF - Simulation Time and Met =10l x|

Year Month Day Hour Minute
crat | 1385 | 10| 1| 0| i

End | 4575 | 4| 0 | 24 | 0

Note: The Met Segments section of the Simulation Time and Meteorological Data
window contains a grid with a list of the meteorological segments and the
operations that they affect. New met segments may be added by clicking ADD
button. Click EDIT to modify existing met segments. To edit a met segment,
highlight the desired segment in the “Met Seg ID” column then click EDIT.
The “Add Met Segment” and “Edit Met Segment” forms are almost identical,
except that the Met Segment name in the ‘Add Met Segment’ form may be
chosen from a drop-down list. The precipitation data set defines the met
segment and therefore, may not be edited in the “Edit Met Segment” form
(Duda et al., 2001). We will not add or edit any met segments at this time.

3. Click OK.
WinHSPF Landuse Editor
This tool allows you to edit the area of each land use contributing to each reach and is useful

for best management practices and modeling various scenarios. This will be further
explained in Exercise 14.

1. Click (Landuse Editor).

£ WinHSPF - LandUse Editor =0 x|
Sources Targets
Available: Selected: Available: Selected:

Add > | PERLND 101 Add > | RCHRES 1
PERLND 102 il RCHRES 4 il
PERLMD 103 RCHRES 2
< “emﬂve PERLND 104 < Remﬂ"e RCHRES 5
IMPLND 101 RCHRES 3
Add All )) PERLND 106 Add All ))
PERLND 105 ﬂ
<< Hemuve All << Hemuve All
Source ID | Source Description | Target 1D | T arget Description | Avea [bores)| &
FERLMD 101 Farest Land RCHRES1 Western Branch, Patusent River 5785
FERLMD 102 Urban or Built-up Land RCHRES 1 ‘wiestern Branch, Patusent River 2830
IMPLMD 101 Urban or Built-up Land RCHRES 1 ‘western Branch, Patusent River 2830
PERLMD 103 Agricultural Land RCHRES 1 ‘wiestern Branch, Patusent River G255
FERLMD 104 Barren Land RCHRES 1 ‘western Branch, Patusent River 382
PERLMD 101 Farest Land RCHRES 4 Morth Callingtan Branch 2774
PERLMD 102 Urban or Buil-up Land FRCHRES 4 Morth Collingtan Branch E41
IMPLMD 101 Urban or Built-up Land RCHRES 4 Morth Collingtan Branch E41
FERLMD 103 Agricultural Land RCHRES 4 Morth Collington Branch 4569
PERLMD 104 Barren Land RCHRES 4 Marth Collingtan Branch 164
PERLMD 108 Water RCHRES 4 Marth Callington Branch Ml
PERLMD 103 Agricultural Land RCHRES 2 South Collingtan Branch 1483
FERLMD 101 Forest Land RCHRES 2 South Callington Branch 1873 LI

Total: 53581

Note: The “Sources - Available” box on the left represents the sources and land
segments, and the “Targets - Available” box on the right represents the targets
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and reaches. The table at the bottom of the window lists each “selected” land
segment contributing to each “selected” reach. Reaches and land segments are
represented in the table if the name of the operation is in the “Selected” box.
Sources, land segments, and targets can be moved back and forth between the

“Selected” and “Available” boxes. The contents of the grid will automatically
be updated.

Note: The values in the “Area” column may be edited. The text below the grid will

indicate the original total area, the new total area, and the difference between
these two. This information allows the user to feel confident that the change
was interpreted as desired (Duda et al., 2001).

2. Click OK.

WinHSPF Control Cards Editor

1. Click

2. Click

Note:

’

il (Control Cards).

DESCRIPTIONS when the following window appears.

i_ Control Window Selectia x|

Chooze a format for editing control cards.

1 Deszcriptions |

This screen allows you to choose which parameters you would like to model in
WIinHSPF. Each tab (PERLND, IMPLND, and RCHRES) contains a list of
corresponding modules and parameters. You can specify which parameters
and modules you want to model by checking the boxes beside the parameters.
For example, if you wanted to model the accumulation and melting of snow
and ice, you would check the box beside “Snow.” When you turn “on” (check
the box beside) a module through this editor, other sections might turn on
automatically because there are rules in the model’s coding that require certain
modules as prerequisites to others. These operating rules are based on the
guidelines in BASINS Technical Note 3: the NPSM/HSPF Simulation Module
Matrix. Following these operating rules, all required and recommended
prerequisite sections are turned on when appropriate (Duda et al., 2001).

The “Pervious Land” tab will be displayed. Make sure that “PWATER” (water

budget pervious) is selected.
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¥ WinHSPF - Control Cards -|Of x|

T Impervious Land T Beaches/Rezervoir: ]

[ ATEMP - Air Temperature Elevation Difference

[T SNOW - Accumulation and Melting of Snow and lce

[+ PWATER - Water Budget Pervious

[T SEDMNT - Production and Removal of Sediment

[T PSTEMP - Soil Temperatures

[ PWITGAS - Water Temperature and Digzolved Gas Concentrations

4, Click the “Impervious Land” tab.

¥ _ WinHSPF - Control Cards - O] x|

FPerviouz Land T

T Beaches/Rezervoirz )

[ ATEMP - Air Temperature Elevation Difference

[T SNOW - Accumulation and Melting of Snow and lce

[+ IWATER - Water Budget Imperyious

[ SOLIDS - Accumulation and Removal of Solids

[T IWTGAS - Water Temperature and Dizsolved Gas Concentrations
[ IQUAL - Quality Constituentz Using Simple Relationships

5. Make sure that “IWATER” (water budget impervious) is selected.

6. Click the “Reaches/Reservoirs” tab.

¥ _ WinHSPF - Control Cards - O] x|

Ferviouz Land T Impervious Land T ‘Beachez/Beservoirs ]

[+ HYDR - Hydraulic Behavior

[T ADCALC - Advection of Fully Entrained Constituents

[ CONS - Conservative Conshituents

[T HTRCH - Heat Exchange and Water Temperature

[T SEDTRN - Behavior of Inorganic Sediment

[T GQUAL - Generalized Quality Constituents

[T DXBX - Pimary DO and BOD Balances

[T HUTRX - Primary Inorganic Mitrogen and Phosphorus Balances

[T PLANEK - Plankton Populations and Associated Beactions

[T PHCARB - pH. Carbon Dioxide, Total Inorganic Carbon, and Alkalinity

7. Note that “HYDR” (hydraulic behavior) is selected, and select “ADCALC.”
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Note: Notice that PWATER is selected in the Pervious Land tab, IWATER is
selected in the Impervious Land tab, and HYDR is selected in the
Reaches/Reservoir tab. These three selections indicate that we will be
modeling overland flow in pervious and impervious land segments and it will
then be routed into the stream reach.

8. Click OK.

Pollutant Selection

HHy 1

il

1. Click Lz | (Pollutant Selection). In this window, we can specify which water
quality constituents we would like to model using HSPF. We will not change
anything in this screen since we are not modeling water quality in this session.

2. WIinHSPF - Pollutant Selection =lalx|

Available: Selected:

F.COLIFORM Add -»
NH3+NHA4

NO3

ORTHO P <- Remove
BOD -
METALS

SEDIMENT

DO

WATERTEMP

- Qﬁncel

2. Click OK.
Point Source Editor

This tool is used to view and manage point sources in the simulation. We will add the PCS
point source that contributes to Reach 4.

1. Click E’ (Point Sources). The “Point Sources” window will open.

“ . WinHSPF - Point Sources o [=] 3|

Available: In Use:

WESTERN BRANCH_WWwTP (O Add > |
<- Remove |

Add All ->> |

<<- Remove All |

=| Show Details Add New | Create Scenario |

LCancel |
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2. In the “Available” box, select “WESTERN BRANCH WWTP (OBS)” and click
“Add->." The record will now be in the “In Use” box.

fL winiPFEFUTEE TS (ol #_WinHSPF - Point Sources =1olx]

Available: In Use: Available: In Use:

Add > o Adds 7| |WESTERN BRANCH WWTP (0
<- Remove <- Remove
Add All ->> _> Add All ->>
<<- Remove All <<- Remove All

I™ Show Details AddNew |  Create Scenario | I” Show Details AddNew |  Create Scenario |

ok | Cancel | oK | Cancel |

3. Click in the box next to “Show Details.” The Point Sources editor will expand.

# WInHSPF - Point Sources (=]

Available: In Use:

Add > WESTERN BRANCH_WWTF [0
<- Remove
Add All ->>
<<- Remove All

Add New | Create Scenario |

~Details of WESTERN BRANCH_WWTP [OBS)

In Uss|Reach | Pollutant | Target Member | MemSubT = |
Mo RCHRES 4 - South Reach, Westem ORYGEM,  WOL
No RCHRES 4 - South Reach, Western BOD, 5D VoL
No RCHRES 4 - South Reach, Western SOLIDS, VoL
No RCHRES 4 - South Reach, Westerm MITROGEN  VOL
No FRCHRES 4 - South Reach, Westerm MITROGEM  [vOL
No RCHRES 4 - South Reach, Western NITROGEN | VOL
No RCHRES 4 - South Reach, Western MNITRITE VoL

i Y

T oo ocoo oo
. L

oK I LCancel |

4, The list under “Details of WESTERN BRANCH_WWTP(OBS)” shows the
pollutants included in the PCS file. The model will not simulate a constituent unless
its corresponding “In Use” box is set to “Yes.” Scroll down until you see “FLOW” in
the “Pollutant” column. Double click the corresponding “In Use” box and select
“Yes.”
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— Details of WESTERN BERAHCH_WwTPF [0OB5)

I 22| Reach | Pallutart | Target Member | MemSub1 « | "I
Mo RCHRES 4 - South Reach, Western MITROGEM | WOL 0 lI
Mo RCHRES 4 - South Reach, Western MITROGEM | WOL 0 111
Mo RCHRES 4 - South Reach, WWestern MITRITE [WOL 0 297
Mo RCHRES 4 - South Reach, Western PHOSPHOR WOL 0
Mo RCHRES 4 - South Reach, Western CHLORIME  WOL I} iﬁ
Mo RCHRES 4 - South Reach, Western PHOSPHOR WOL 0

—> ez  RCHRES 4 - South Reach, \Western FLOW [%OL o
1| I »

(0] 4 Cancel
5. Click OK.

Note: If you want to use point source data other than that provided by BASINS,
click ADD NEW. The following window will appear.

# . WinHSPF - Add Point Sou

X

| Simple Create

Import MUTSIM Format

Convert All MUTSIN: in Project

Advanced Generation

The following gives explanations for the buttons on the “Add Point Source” window.

Simple Create: This tool allows you to add point source data by specifying a scenario name, a reach to
which to add the point source, the pollutant(s), a facility name, and a daily load.

Import MUTSIN Format: This allows you to select a Mutsin file that contains the point source
information. The user must specify a scenario name, a reach to which to add the point
source, the pollutant(s), and a facility name.
Convert All MUTSINSs in Project: This tool scans the HSPF input sequence (the UCI file) and converts
any found Mutsin files to WDM data sets in the project WDM file.
Advanced Operation: This tool allows you to modify the time series in your point source data file.

Note: You might want to edit values in one of the point source data sets. You can do
so by highlighting a field in the row associated with the desired data set and

111
then clicking the “List/Edit Selected Point Sources” button, E

Also, you

can view the results graphically by clicking the “Graph Selected Point

Sources” button, "I" You can delete a point source by clicking the “Delete

Sy
Selected Point Sources” button, @I
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WinHSPF Data Editor

1. Click m (Data Editor). The following window will appear.

2 WinHSPF - Input Dats _lol =1

- GLOBAL A
- OPN SEQUENCE

- FTABLES

- EXT SOURCES

- FORMATS

- NETWORK

- EXT TARGETS

~ SPEC-ACTIONS

-~ SCHEMATIC

- MASS-LINK

~FILES

- CATEGORY ~
- MONTH-DATA

~ PATHNAMES

& PERLND

& IMPLND

& RCHRES

. TPy =

Note: The “Input Data Editor” window contains a tree diagram of all the possible
blocks and tables of HSPF. The tree diagram is navigated by clicking on an
item name. Double clicking on an item name reveals the sub-items within
that item if any exist.

2. Click HH next to “PERLND.”
3. Click HH next to “PWATER.”
4, Double click “PWAT-PARM2.”

= Edit PERLNDIPWAT-PARM2 - 1o x|

[ Show Description

OpMum | Description FOREST| LZ8M| INFILT| LSUR|  SISUR|  KWARY| AGWRC
101 Urban or Built-up Land 0 B 016 380 0.013207 0 0.95
102 Agricultural Land 0 6 0.16 350 0.013207 0 0.98
103 Forest Land 1 B5 0.16 350 0.013207 0 0.98
104 Barren Land 0 B 016 380 0.013207 0 0.95
105 Wietlands/\ater 1 bS5 0.1 350 0.013647 0 0.95
Table: PWAT-PARMZ, Second group of PWATER Farameters. ;I

Parameter: AGWRC is the bhasic groundwater recession rate if EVARY is zero and there
is no inflow to groundwater (rate of flow today/rate yesterday).

*** £ PLE> FOREST LESH INFILT L3UR SL3UR EWVART AGWRC
WEE w = [in} [in/hr) [ft) [1/in} [1/day) _I
=

Cancel Apply | Help |

Note: This editor is used to modify site-specific and calibration parameters varied in
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model calibration. Notice that as you click in each column corresponding with
a parameter, the definition of that parameter is displayed in the text box below
the table.

S. Click HELP.

E? HSPF Manual -1o x|
0 = B

Hide Back Print  Options

Contents ||ﬂdex | Eearchl

= 23 PWATER nput |
5] PrvaAT-PARM
5] PWAT-PARM PWAT-PARM?2
[5] PrvAT-PARM
[5] PrvaT-PARM
E mﬂ_iﬁm Second group of PWATER. parameters
[E] PWAT-PARM
[E] MONHNTERC
[E) MOM-UZEN
[E] MON-MANMI
[81 MON-INTERF
[81 MONHRC
[E] MON-LZETP
[E] PWAT-STATI
B IRRIGPARM
[E IRRIGPARM:
[E] CROP-DATE!
Bcropstact || 0 c ot e e
[5] CROP-SEASH
BsoLData || ot e
@ SOIL-DATA? END PWAT-PARMZ

[E S0IL-DATAS «
— Example -
4 | » H
1 | »

Note: Notice that the HSPF Manual opens to the page corresponding to the table
PWAT-PARM2. This page of the manual provides additional details about the
individual parameters in the PWAT-PARM2 table, including definitions and
limits.

Layout

PWAT-PARMZ
f-rangerE-- - - - - - - - o - - - oo ———————— e pwatpar:

6. Scroll up to the top of the “Contents” at the left side of the manual.
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7.

E? HSPF Manual =18lx|

S i
Hide Eack Frint Dptions

Contents ||ﬂdEX I §earch|

@ HSPF User's Manual
(23 Intraduction
([ General Principles
(23 Functional Description
= 23 Users Control Input

[8] GLOBAL Block
[£] FILES Block
(23 OPN SEQUENCE Block
[E] <Operation-type> Block
= 3 PERLND Black
(23 General input
3 ATEMP input
(L SNOW input
= {3 PWATER input
2] PWAT-PARMI
2] PWAT-PARMZ
[E] PWAT-PARM3
[E] PWAT-PARMY
5] PWAT-PARMS
[E] PWAT-PARME
2] PWAT-PARM?

4

(L1 GENERAL INFORMATION AND COMYENTION:
B ‘3 FORMAT OF THE USERS CONTROL INFUT

PWAT-PARM2

Second group of PWATER

parameters
1
5 0
Layout

PWAT- PARMZ
- ranger€-——————---———————

= END| EWAT-PARMEZ
-
| B
1| »

Note: The tree diagram in the “Contents” shows the general format of the HSPF
manual. The “Functional Description” section contains detailed explanations

of the algorithms and scientific basis of HSPF, while the “Users Control Input”

section contains operational details.

Scroll down in the “Contents.” Within the “User Control Input” section, open the
‘Catalog for PERLND module’ folder, and click on the *‘Group PWATER’ page.

E? HSPF Manual I [T
G -

Hide Back Frint Options

Contents ||ndex |§earch|

(21 MUTSIN Block -]
(23 BMPRAC Block
1 REPORT Block
[E] FTABLES Block
(21 FTABLES forthe PERLND Ap
(21 FTABLES forthe RCHRES Ay
(23 TIME SERIES LINKAGES
(L1 Time Series Catalog
= 23 Catalog for PERLND module
[21 Group EXTHL
[E1 Group ATEMP
5] Group SNOW
BlGioun PWATER,
[21 Group SEDMNT
[E] Group PSTEMP
[E1 Group PWTGAS
[21 Group PoUAL
21 Group MSTLEY
5] Group PEST
[E1 Group MITR:
[E1 Group PHOS
[E] Group TRACER
(L Catalog for IMPLND module -

4| »

Group PWATER
<-——- Member -——> K Units
Max subscr 1 {external)
Name values n
1 2 d Engl Me

Time series computed by module sect

PERS 1 1 * in jilhie
CEPS 1 1 # in e
SURS 1 1 * in e
Uz g 1 1 * in iy
IFWS 1 1 * in jilhie
LZS 1 1 # in 0 »
] I _>I_I

Note: This page is known as the “Time Series Catalog” for PWATER. The “Time

Series Catalog” lists all time series computed by each HSPF module, including

the units of the output. It also lists the possible input time series for each
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10.

module. The list of input time series indicates either prerequisite sections that
must be turned on or time series that must be supplied externally (such as
through the input WDM file) for a particular module section.

Browse the HSPF Manual as much as you wish. When you are finished, close the
manual by clicking the “X” in the top right corner.

Toggle to WinHSPF. Click OK or CANCEL in the “Edit PERLND:PWAT-PARM2”
window.

Click CLOSE.

WinHSPF Output Manager

2.

Click

rz: (Output Manager). The Output Manager allows you to select what will be

written as the output time series. For each output type, you can choose one or more
locations for which output will be generated.

Note:

The first output type is Hydrology Calibration. This button will already be
selected when entering the Output Manager. With this button selected, the list
below the radio buttons displays the HSPF calibration locations within the
current HSPF project. Under the buttons is a box explaining which output time
series will be generated during the HSPF model run.

You can add calibration locations to this list by clicking ADD. A window will
appear that lists all available calibration locations (i.e., the reaches of the
watershed) along with two text fields. The user must choose one of the
calibration locations, and then enter an eight-character identifier for that
location. This identifier is used as the location ID attribute in the WDM time-
series data sets that will be created. The user may also enter a “base data set”
number for the data sets to be created. The new data sets will be numbered
consecutively as the available data sets following the base number. In this
section, we are modeling only flow, so we will only specify output locations
for “Flow.”

Click the radio button beside “Flow.”
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;_ WinHSPF - Output Manager - |EI|5|

— Output Type
= Hydrology Calibration

ALUA I Us
. lLink ans

= Other

Streamtlaw output will be generated at each 'Flow' autput location.

Output Locations:

M arne | Dezcrption
RCHRES 4 South Reach, “Western

Note: Notice that “RCHRES 4” is the only stream listed in the output locations. We
would like to look at the flow in “RCHRES 5” because there is a flow gage
located on Reach 5.
3. Highlight “South Reach, Western” in the “Description” text box and click REMOVE.
4, Click YES when the following message appears.

i_ Delete Query x|

Do you want to permanently delete the output WDM timezenes?

S. Click ADD.

6. Highlight “RCHRES 5 (Western Branch Patux).”

. WinHSPF - Add Dutput =

Operation:

RCHRES 1 Mwestern Branch Patus]
RCHRES & [Morth Collington Bra)
RCHRES 3 [South Collington Bra)
RCHRES 2 [Southwest Branch 'Wes]
(BCHBES & western Branch Patux]
RCHRES 4 [South Reach, \Western]

7. Click OK. Notice that “RCHRES 5” is now listed as an output location. This means
that we will be able to view the simulated flow data for Reach 5.

8. Click CLOSE to exit the “Output Manager.”
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D. Running WinHSPF
In this section, we will run our WinHSPF model for the West Branch of the Patuxent River.

QUESTION ANSWERED:
4) How do I run my WinHSPF model?

1. Click 1 (Run).

2. If the following message appears and asks if you want to save changes that have been
made, click SAVE/RUN. Your .uci file will be saved and the model simulation run
will begin.

1 Confirm Save UCI x|

Changes have been made since your last Save.

Do you want to save theze changes?
Cancel |

Note: A screen will appear, indicating that the input file is being processed and run.
When this disappears, the model run is complete.

Note: We would like to compare the simulated flow for Reach 5 (recall that we
specified RCHRES 5 as a “Flow” output location) with observed flow in
Reach 5. Before we do this, we need to add the gage data to the current
project.
3. Close the WinHSPF window.

IMPORTANT NOTE: IF YOU DO NOT CLOSE THE WINHSPF WINDOW,
YOU WILL NOT BE ABLE TO COMPLETE SECTION E.

E. Adding Gage Data to the Project

QUESTION ANSWERED:
5) How do I add gage data to my WinHSPF project file?

In this section, we will download the USGS gage data for Reach 5 and add it to the WestPat
project *.wdm file. If you are unable to connect to the internet, please skip to step 13.

1. Within BASINS, from the File menu, select Download Data.

2. Check the box next to “Daily Discharge” within the “USGS Stations from NWIS”
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frame. Your window should look like the following.

: Download Data 1]
Fiegion to Download Hydrologic Unit 02060006 LI
BASINS

™ DEM Shape ™ GIRAS Land Use T NED [ Census [ MetStations
I DEM Grid ™ Legacy STORET CNHD  T303d) T Aet Do

i Mational Hydrography Dataset Plus
Al

™ Elevation Grid
™ Flow Direction Grid

™ Flow Accumulation Grid

[ Catchments
™ Hydrography
™ Hydrologic Units

™ Streamgage Events

Station Locations from US Geological Survey Mational YWater Information System
¥ Daily Discharge I ‘Water Quality I Measurements ™ Ground Water

DataValues from US Geological Survey National Water Information System
’7 Station Locations must be selected on the map befare datavalue download

Mational Land Cowver Data 2001

™ Land Cowver ™ Impervious I~ Canopy ™ 1992 Land Cover

™ NED 30m

EPA STORET ‘Water Quality
’]_ Stations ™ Riesults (available after Stations are selected on meap) ‘

I Merge ™ Clipto Region

Help | Cancel | Dovenload |
4

3. Click DOWNLOAD. After a moment, the following window will appear.

Download Complete x|

Cownloaded Layer: NWIS Dalty Discharge Stations

On the map, notice the new layer called “NWIS Daily Discharge Stations”. With this
layer active, select the USGS daily discharge site at the downstream end of RCH 5, as
shown on the map below. Note that you may want to move the Observed Data
Stations to the top of the legend and change the point size/color to make the stations
more visible.

abupoer
Models  Launch .llnir% Edt  View I’hgm Watershed Deineabion  Shapefle Edtor  GIS Tooks  Help
DFRS¢ ¥ <PREA S (-8 &.we @ 13 2 b w o M-

¥ Observed Dats Statises

HIFENBE2EE Y AN 199 Mewrs POIIS1E Y ATIIIIE Kilomenees
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The selected station is USGS discharge site “01594526” with a station name of “Western
Branch at Upper Marlboro, MD”. You could use the identify tool to be sure that you have

selected the desired station.

Now that we have identified the station for which we would like to download the daily
discharge data, we will use the Data Download tool to download the actual discharge data.

5. From the File menu, select Download Data.

Your window should look like the following.

o
—.~Download Data

Fegion to Download

BASING
[~ DEM Shape ™ GIRAS Land Use I~ NED ™ Census ™ Met Stations
" DEM Grid I Legacy STORET ™ NHD I 303(d) I et Data

—Mational Hydrography Dataset Plus

Al " Catchments

" Elevation Grid ™ Hydrography

I Flow Direction Grid I Hydralagic Units

™ Flow Accumulation Gridd [~ Streamgage Events

" Daily Discharge I ‘Water Quality [ kdeasurements

—Station Locations from US Geological Sursey National Water Information Systerm

I Ground ‘Watet

¥ Daily Discharge I Wiater Quality I Measurements

i~ Data Values from US Geological Survey Mational VWater Information System

—Mational Land Cower Data 2001
[ Land Caver I Impenious ™ Canopy
™ MWED 30m

™ 1992 Land Cover

—EPASTORET Water Quality

[~ Stations = Besults (availakle efter Stations are selected on mag)

™ Merge ™ Clipto Region Help | Cancel | Download I
4

7.

Click DOWNLOAD. The following window will appear. Click *Add data to

existing WDM file’, and then click Browse to select the file shown below:

f_L Flow post-processing options

After downloading Flow data,

= Add individual files (one per station) to project

Check the box next to “Daily Discharge” within the “USGS Data from NWIS” frame.

(=14

 Add data to new WO file: |C:‘-.EFASINS\data‘-,DZDEDDDB‘\nWiS\fIDW.de Browse... |
& Add data to existing WD file: IC:\BAS|NSHmDdelout‘\WestPaﬂ\WestPat.wdm Browse... I

" Do not add data to project

Ok |

4

4-24




BASINS/HSPFE Training Exercises

Note: In order to compare the simulated data to the observed data, we need to add the gage
data to a WDM file. We will add the gage data to the project WDM file (WestPat) that was
created when we built our HSPF project.

8. Click OK. A message will indicate that 1 WDM data set was added.

B x|

1WD Datasets added

9. Click OK.

Download Complete il

Daownloaded Data file; CHBASINSYmodelouthwWestFat\WestPat wdm

10.  Click OK again.

11.  The following window will appear.

1 Data Sources -0 il

Fle Edit Wew Analysis Help

=
CABASINS datai020B0006vmetimet. wdm (209)
L CABASINSmodeloutiestPativestPat wdm (13)

12.  Close this window by clicking the “X” in the top right corner.

If for some reason you were unable to download the data through the Data Download tool,
the downloaded data has been provided for you. You may import this data into the
w_branch.wdm file using WDMUIil by going through the following steps. If you were able
to import the data successfully, you may skip steps 13 through 30 below and continue
with Section F.
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13. From the Start menu under Programs, select BASINS and then WDMUJtil.
14, From the File menu, select Open.
15. Navigate to c:\basins\modelout\WestPat and click on “WestPat.wdm.”

16. Click OPEN. The WDM will open:

File Tools Scenarios Locations  Constituents  Time Series  Help

Scenarios Locations Constituents
0of 2 All None 0of 2 All None Dof 8 All Mone
PT-0BS RCH4 BOD. 5-D ~
WESTPAT RCH5 CHLORINE

FLOW

NITRITE

NITROGEM

OXYGEN, bl

Time Series - 12 of 12 available time zenies in list [0 not on WDM file): 1 zelected.

+'<:++JJJ o M

Type File DSN Sc:enano Loc:atlon Congtituent | Start End Nval Station Ma

WDM w_branch ?001 F‘T-DBS HCH4 DYGEEM, 19?0!1;’1 1995#12#31 9498 WESTER!
WOM w_branch 7002 PT-0BS  RCH4 BOD.5D 1370/ 1335112/31 3436 WESTER!
WDM w_branch 7003 PT-0BS  RCH4  S0LIDS, 19704141 1995/12/31 94596 WESTERL
WDM w_branch 7004 PT-0BS  RCH4  NITROGEM 15704141 1395/12/31 9496 WESTER!
WDM w_branch 7005 PT-0BS  RCH4  NITROGEM 1970441 1995/12/31 9436 WESTER»

Pl =<
jsalba

Dates

Reset | Start ﬁ End
EEE10 1 ro [1323] 430
Common [1385[10[1 to [1983] 4[30 [Wative |

Current

17. From the File menu, select Import.
18. Navigate to c:\basins\extra training files\ and select “discharge.txt.” Click OPEN.

19.  Click OK if the following message box appears.

Mo Scripts Found Yet

Ix

Ilse the Find button to locate scripts.
Look For the Scripts directory where this program is installed.

20.  The “Script Selection” window will open. Click FIND.

21. Navigate to c:\basins\models\nspAWDMUJtil\scripts and select
“UsgsDvWeb_MDY_2001.WS.”

22.  Click OPEN.

23. Under script file, select the record that corresponds to “USGS Daily Web Values
(mm/dd/yyyy) — 2001 Format.” It will turn blue.
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w. Script Selection for importing C:'\BASINS'\Extra Training Files\discharge.txt |E| |i|
Description ‘ Script File I |
Blank Script

""Haurly Precip, OrrLine Farmat NCDCTD-3240" Edit |
"UISGES Daily Webh Yalues (mm/ddfnand - 2001 Format” | Ymodels), /

Find

4|

Debug |
Cancel |

24.  Click RUN.

The “Script Selection” window will disappear and a run window will open, indicating
that the discharge data is being processed and added to the current WDM project.

" Reading E:"-.,BASINS"-.,mudequt"-.,discharge.t:-c::l:‘; B ] |

USGS5110133895111/06/19301121

1] 363% 100

Eztimate Done at: 5:17:32 PM [5 seconds)

When this process is complete, a new record will appear in the time series list. It will
be highlighted (yellow).

— Time Senes - 13 of 13 available time zeries in list [1 not on WDHM filel: O zelected. —————

=] 214]¥] # 2| 8] Al | Mone|
Tupe FI|E |DSN|Scenann |L|:u:at||:|n |Ennstltuent |Start |En|:| |NvaI|E:|

DI w_branch 7003 PT-OBS RCH4 FHOSPHOR 1370414 1335112431 3496 %
DI w_branch 7003 PT-OBS RCH4 CHLORIME 1370414 1335112431 3496 %
D w_branch 7010 PT-OBS RCH4 FHOSPHOR 137044 1335112431 9496 *
D w_branch 7011 PT-OBS RCH4 FLOW 19704141 199512431 5496

[n-temany <in memans: 1 OBSERVED 01534526 FLOW 198541041 199512/ 3744 |
=1

25. Click the new time series. It will turn blue when selected.

H
26.  Inthe “Tools” frame, click [#== rl (Write Time Series to WDM).

27. In the Output DSN text box, type “27.” Leave other fields as they are.
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28.

29.

30.

Specify Dutput D ata-set Number[s];
Select/Enter Scenario, Location, Constituent as needed;
Click Write button to store data on WDM file.

f* Use common period for all data sets, as defined on main form
" Use full period for each data set

DSHAD | Output D5M| Scenario | Location | Constituent |
i1 OBSERYED 01594526 FLIO%W |
Write | LCancel |
Click WRITE.

Click OK when you are told that the file was stored successfully.

From the File menu, select Exit.

F. Viewing WinHSPF Output in GenScn

QUESTION ANSWERED:
6) How do | use GenScn to view my simulation results?

In this section, we will view the results of the simulation using the GenScn postprocessor.
GenScn was designed to manage large volumes of input, output, and calibration data used by
and produced in models such as SWAT and WinHSPF. This software has many different
applications; however, in this exercise we will focus on those necessary for viewing the
output from WinHSPF and corresponding gage data.

1.

From the Start menu under Programs, select BASINS and then WinHSPF.

From the File menu, select Open or click the “Open Existing Project” button,

Navigate to c:\basins\modelout\Westpat\ and select “WestPat.uci.” Click OPEN.

Click

o

(View Qutput button).

Note: The “GenScn Initialization from BASINS” window will appear. This form has

six different tabs because many types of files can be viewed within the GenScn
interface.
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" GenScn Initialization from BASINS ol x|

Overview | MetDate | PLTGEN | SwAT Output | HSPFOutut | Obs Wi Data

BASINS Project ALL -
Project Type HSPF v]

Map File Name CABASINS\modeloutywestpatywestpat.mar Browse

Load Existing | 0K | Cancel |

Note: The “Overview” tab shows information about the GenScn project that is being
created from the BASINS interface.

5. When used from BASINS, by default the appropriate settings will be selected. Click
OK.

The GenScn window will open. This window has six sections: Locations, Scenarios,
Constituents, Time Series, Dates, and Analysis.

™ GenScn: westpat =lolx|
Fle  Analysis Map Locations Scenarios Comstituents Time Series  Help
—Locations — Scenarios — Consti
Q|8 |a|e| @ &+ Bl sl Al | None || 904  [CAK]] None| 00f15 Al | Nons
— ® All " Location ® All " Location
COMPUTED ATEM -
OBSERVYED BOD, 5-D
PT-0OBS CHLORINE
WESTPAT cLou
DEWP
FLOWY
NITRITE
NITROGEN
I OXYGEN,
PEVT
PHOSPHOR
PREC
S0LIDS. =l

- Time Series (0 of 222)

H=IN] 2(41] 5] B2 L _All_| None |
\ |

Legend r Tahl

—Dates

Cataloging Unit Boundaries <not set».
Streams
Outlets

Subbasins

—Analysis

111
alli

Oode | O

State Boundaries

O 8

A
N

idl |

Recall that we want to look at a graph that includes both the model’s flow simulation values
and observed flow values for the same reach in order to ascertain how well we are simulating
flow in Reach 5. We will graph both times series in the following steps.
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3. In the “Scenarios” frame, select “WESTPAT” and “OBSERVED.”
4. In the “Constituents” frame, select “FLOW.”
—Scenanos ——  Conshituents ——————
2of 3 All | MHone 1ol 8 All | HNone
i+ All = Location i+ All = Location
OBSERVED EOD. 5-D
CHLORINE
NITRITE
NITROGEN
OXYGENM.
PHOS5FPHOR
SOLIDS,
5. In the “Time Series” frame, click I (Add to Time Series List). All time series for

flow within the “WESTPAT” and “OBSERVED?” scenarios will be listed in the Time
Series section.

6. In the “Time Series” frame, highlight the record that corresponds to the scenario
name “WESTPAT.” Press SHIFT and highlight the “OBSERVED” time series.

Time Senes [2 of 93]

+—S| 2/4|¥] & El2| 2| @ A1l None
Type | File |D5M | Scenario | Location | Comstituent| Start | 5 Day

WO w_branch 1 OBSERYED (1534526 FLOW 1385/104 46333
WD w_branch 10001 WESTPAT RCHS FLOW 1570414 40587

7. In the “Analysis” frame, click 'IIII (Generate Graphs).
8. Make sure the “Standard” box is checked.

[ craph -lolx|

Select desired plots. then press Generate.

Mone | [ Multiple W@ Plots
[v Standard

[~ Besidual [TS2 - TS1 vz time]

[~ Cumulative Difference vs. lime

[~ Bar Chart

[~ Flow/Duration

[~ Difference [TS2 - T51] vs. TS51

[~ Scatter [TS2 ws. TS1) [ 45 deo/rearess lines

{* Current Period ) Storms

Generate Cancel
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0. Click GENERATE. The plot window will open:

Gensch Standard Plot =10l x|
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|

U"“-—l Ak
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| 1y
L W SRR 1 1T
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10.  After looking at the graph, exit the GenScn Standard Plot. Click CANCEL to exit the
“Graph” window.

11.  Zoom in on smaller time periods by changing the start and end dates in the “Dates”
frame. Repeat steps (6-9) to look at the graph of this time period.

12.  Exit any open graphs and close GenScn. You don’t need to save any changes.

Special Note about HSPF Errors in WinHSPF:

From time to time changes made to the User Control Input (*.uci) file through WinHSPF (or
a text editor) are interpreted as errors the next time the *.uci is opened in WinHSPF. This
condition is indicated by a message similar to the following when opening a *.uci file in
WinHSPF:

“_HSPF Problem x|

Error interpreting UCI File 'basewq’.

See the file 'basewq_ech’ for more details.

! Continue || View Errors

Details of the error encountered are written to the file known as the “Echo” file which is
named with the same base name as the *.uci file only with a *.ech extension (e.g.,
w_branch.uci will have an “Echo” file named w_branch.ech). Clicking the “View Errors”
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button will provide a view of the *.ech file at the point of the first error. HSPF error
messages are enclosed in asterisks as shown below:

“_WinHSPF Error View of basewg.ech ol =l

COPY 100
EHD IHGRF
ENDI OFH SEQUEHCE

FSYII/WARNING ID: 211 23

The text ' PERXHD 191' is not recognized as a heading,
operation-type or delimiter, and thus will be ignored. Is it
misspelled or placed in the wrong fields?

* % ¥ > X ®
* % % ¥ * * %

FIHISHED PROCESSIHG OPH SEQUEHCE BLOCK

PROCESSING FIABELES BLOCK

USERS COHTROL THPUT IS:
FTABLES

FTABLE 680

<] |
<<| = | 4 = | >>| of 100 Ir'up.'num Outp « Close | Print |

The *.ech file may also be opened in any text editor (such as Wordpad). Searching for the
text “Error’ will take the focus to the portion of the file containing error messages. Once the
error messages are found, the cause of the problems can be identified and resolved.

It should also be noted that it is also possible to encounter errors by HSPF during simulation
that prevent the model from running to completion. If the simulation does not appear to run
to completion (for example the output time series plots do not contain data for the full span
of the run), the *.ech file should be examined for error messages. The *.ech files are
generally located in the same directory as your *.uci file.

Reference:
Duda, P., J. Kittle, Jr., M. Gray, P. Hummel, R. Dusenbury. WinHSPF Version 2.0: An

Interactive Windows Interface to HSPF (WinHSPF), User’s Manual. Washington,
D.C.: U.S. Environmental Protection Agency, 2001.
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